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SUMMARY: 24 

This protocol presents a collection of sarcomere, calcium, and macroscopic geometrical data 25 

from an actively-contracting cardiac trabecula ex vivo. These simultaneous measurements are 26 

made possible by the integration of three imaging modalities.  27 

 28 

ABSTRACT: 29 

In cardiac muscle, intracellular Ca2+ transients activate contractile myofilaments, causing 30 

contraction, macroscopic shortening, and geometrical deformation. Our understanding of the 31 

internal relationships between these events has been limited because we can neither ‘see’ inside 32 

the muscle nor precisely track the spatio-temporal nature of excitation‑ contraction dynamics. 33 

To resolve these problems, we have constructed a device that combines a suite of imaging 34 

modalities. Specifically, it integrates a brightfield microscope to measure local changes of 35 

sarcomere length and tissue strain, a fluorescence microscope to visualize the Ca2+ transient, and 36 

an optical coherence tomograph to capture the tissue’s geometrical changes throughout the 37 

time-course of a cardiac cycle. We present here the imaging infrastructure and associated data 38 

collection framework. Data are collected from isolated rod-like tissue structures known as 39 

trabeculae carneae. In our instrument, a pair of position-controlled platinum hooks hold each 40 

end of an ex vivo muscle sample while it is continuously superfused with nutrient‑ rich saline 41 

solution. The hooks are under independent control, permitting real‑ time control of muscle 42 

length and force. Length wise translation enables the piecewise scanning of the sample, 43 

overcoming limitations associated with the relative size of the microscope imaging window 44 
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(540 μm by 540 μm) and the length of a typical trabecula (>2000 μm). Platinum electrodes at 45 

either end of the muscle chamber stimulate the trabecula at a user-defined rate. We exploit the 46 

stimulation signal as a trigger for synchronizing the data from each imaging window to 47 

reconstruct the entire sample twitching under steady-state conditions. Applying image-48 

processing techniques to these brightfield imaging data provides tissue displacement and 49 

sarcomere length maps. Such a collection of data, when incorporated into an 50 

experiment‑modeling pipeline, will provide a deeper understanding of muscle contractile 51 

homogeneity and heterogeneity in physiology and pathophysiology. 52 

 53 

INTRODUCTION: 54 

Superfusion of isolated cardiac muscle tissue preparations is a standard and widely used protocol 55 

for studying cardiac ionic activation and mechanics1. In particular, the isolation of trabeculae, 56 

rod-like structures from the ventricular walls, has enabled assessment of phenomena including 57 

the length‑dependent activation of contraction2, stretch-dependent response of contraction3,4, 58 

and diastolic viscoelasticity5 of cardiac tissue. Ter Keurs, the initiator of this technique of 59 

superfusing isolated trabeculae, initially used a combination of fluorescence imaging for Ca2+ 60 

measurements and laser diffraction for determining sarcomere lengths2,5. Since these early 61 

studies, it has become increasingly common to extract sarcomere length information with a 62 

greater spatial resolution using 2D Fast Fourier Transform (FFT)-based techniques6 on brightfield 63 

microscopy images. The two imaging systems allow a partial assessment of the underlying 64 

relationship between Ca2+ release and sarcomere-length-dependent force production.  65 

 66 

Cardiac muscle is striated, with the visible banding associated with an underlying series of 67 

contractile units consisting of thick and thick filaments. The interaction of these constituent 68 

filaments that make up sarcomeres underlies force generation, which commences as follows. A 69 

depolarizing electrical signal, or action potential, causes voltage-dependent L-type Ca2+ channels 70 

in the cell membrane to open. The ensuing cellular influx of Ca2+ induces the release of Ca2+ from 71 

the sarcoplasmic reticulum (SR), an intracellular Ca2+ store, in a process known as Ca2+-induced 72 

Ca2+ release7. This sudden increase in intracellular Ca2+ concentration from nanomolar to 73 

micromolar range enables force production to occur. Ca2+ pumps continuously extrude Ca2+ out 74 

of the cytosol back into the SR and extracellular compartment. When the intracellular Ca2+ 75 

concentration returns to nanomolar range, force production ceases, and the muscle relaxes. 76 

During force production, the constituent thick and thin filaments slide over one another. The 77 

sarcomere length dictates the relative extent of overlap and, therefore, the potential for force 78 

production of the muscle macroscopically.  79 

 80 

In this paper, we extend these fluorescence-brightfield imaging techniques to include optical 81 

coherence tomography (OCT). OCT utilizes the physical principle of interference and is capable 82 

of garnering the geometric deformation of tissue to understand muscle contractile 83 

heterogeneity8. Our device (Figure 1) uses a spectral-domain OCT (SD-OCT) system. In SD-OCT, a 84 

beam splitter splits the light from a broadband short coherence-length superluminescent diode 85 

into reference and measurement arms. The reference arm contains a fixed-mirror, and the 86 

measurement arm contains a 2D-galvanometer to steer the light. Light backscattered from the 87 

sample is collected and interferes with the reflected light in the reference arm to form an 88 



interference pattern. The depth information is encoded in the frequency of the spectral fringe. 89 

To extract the information, the signal is passed through a spectrometer and an inverse FFT is 90 

applied to the result. The corresponding 1D signal represents the structures at different depths, 91 

corresponding to changes in refractive index9 (A-scan). By steering the laser in a single axis, one 92 

can construct a cross-section of the sample of interest (B-scan) and, similarly, by repeating the 93 

process in a step-wise pattern in the remaining axis, a three-dimensional image can be generated 94 

(C-scan). By extension, one can collect a series of B-scans at a single slice for a repeating time-95 

varying subject based on an external trigger and repeat to generate a four-dimensional scan, 96 

representing a time-varying volume10. 97 

 98 

In integrating the three imaging systems, we have considered the following two principles. First, 99 

imaging sensors should not detect light from an alternative imaging modality, and second, the 100 

physical design should contain free space for at least three simultaneous imaging planes. To 101 

address the first requirement, the brightfield microscope uses a 660 nm wavelength LED to 102 

illuminate the sample in an inverted configuration. The fluorescence microscope is in an 103 

epifluorescence configuration where the same objective lens is used for both excitation and 104 

collection of the emitted light. The excitation light has a wavelength of between 340 nm and 105 

380 nm, and a photomultiplier tube (PMT) measures the emitted light at a wavelength of 510 nm. 106 

A pair of dichroic mirrors enable these two optical paths to share the same physical footprint 107 

without interfering with the opposite measurement (Figure 2). Finally, the OCT uses broadband 108 

(100 nm spectral width) light with a central wavelength of 840 nm, distinct from the other two 109 

modalities. Due to the low-coherence nature of the light used for OCT, any scattered light from 110 

the brightfield-fluorescence sources will not contribute to the interference pattern that encodes 111 

depth information. For the second requirement, the housing design for the capillary tube has 112 

accessible optical pathways to the anterior, inferior, and superior planes of the sample. During 113 

experiments, two platinum hooks hold a trabecula within a capillary tube perfused with 114 

oxygenated Krebs-Henseleit (KH) solution. The galvanometer head of the OCT is oriented 115 

orthogonally to the brightfield-fluorescence imaging pathway to take advantage of the third 116 

orthogonal optical plane (Figure 3).  117 

 118 

This paper outlines the design considerations for building a device capable of simultaneously 119 

imaging calcium, sarcomere length, and muscle geometry. To demonstrate these measurement 120 

capabilities, we describe the process of isolating a ventricular trabecula, the preparation of the 121 

necessary buffer solutions, along with the critical steps involved in the handling and fluorescence 122 

loading of an ex vivo trabecula. Finally, this paper outlines the processes required to translate the 123 

dataset into more useful visualizations. 124 

 125 

PROTOCOL: 126 

The University of Auckland’s Animal Ethics Committee approved the handling of rats and the 127 

preparation of tissue samples. 128 

 129 

1. Imaging calibration 130 

 131 

1.1. Brightfield microscope pixel calibration 132 



 133 

1.1.1. Fill the measurement chamber with distilled water. 134 

 135 

1.1.2. Place a diffraction grating with known lines per μm into the measurement chamber. 136 

 137 

1.1.3. Press F1 to enable the capture and adjust the Frame Rate [Hz] until the diffraction grating 138 

is clearly visible (Figure 4A). Ensure that the diffraction grating runs parallel with the edge of the 139 

frame. Press F1 again to stop capture. 140 

 141 

1.1.4. Set the Total Images to Capture? to one, press Ctrl + Shift + S to stream data to disk, and 142 

press F1 to capture an image of the diffraction grating. 143 

 144 

1.1.5. Open ImageJ and import the diffraction grating image (File > Open > Select Calibration 145 

image). Holding shift, draw a line that encompasses 20 light and dark bands of the diffraction 146 

grating. 147 

 148 

1.1.6. Calibrate the image (Analyze > Set Scale). The length of the line from Step 1.1.5 sets the 149 

Distance in Pixels value. Set the Known Distance value to 20 times the lines per μm 150 

measurement and the Unit of Length to µm. The inverse of the scale is the number of 151 

micrometers represented by a pixel. 152 

 153 

1.2. OCT depth resolution calibration 154 

 155 

1.2.1. Measure the thickness of a glass microscope slide using Vernier calipers. 156 

 157 

1.2.2. Turn on the OCT laser source. 158 

 159 

1.2.3. Cover the galvanometer head and click Get BG to measure the background interference 160 

pattern and subtract it from the measurement (Figure 4B). 161 

 162 

1.2.4. Clamp the measured glass microscope slide (from Step 1.2.1) in the measurement arm of 163 

the OCT. 164 

 165 

1.2.5. Click Live Stream to view the OCT image. Adjust the glass microscope slide until it is visible 166 

within the B-scan. 167 

 168 

1.2.6. To capture the B-scan image, set Range Y (Steps) to one, click Stream B-scan Data?, and 169 

click Acquire. 170 

 171 

1.2.7. Import the B-scan image into ImageJ (File > Open > Select B-scan). Holding shift, draw a 172 

line between the boundaries of the glass microscope slide. 173 

 174 

1.2.8. Set the scale (Analyze > Set Scale). Set Known Distance to the measurement collected in 175 

Step 1.2.1. 176 



 177 

1.2.9. To calculate the depth resolution in air, correct for the refractive index of the microscope 178 

slide (nglass = 1.5175) 11  by multiplying the measurement per pixel value by nglass. 179 

 180 

NOTE: The nglass quoted is for borosilicate glass. Microscope slides can be made from different 181 

materials. Use the appropriate refractive index for the slide measured. 182 

 183 

1.2.10. To scale the depth resolution for myocardium, divide the value from Step 1.2.9. by 184 

nmyocardium = 1.38 (value reported previously12). 185 

 186 

2. Muscle sample preparation 187 

 188 

2.1. Prepare the dissection rig. 189 

 190 

2.1.1. Pour some of the dissection solution (outlined in Table 1) into a small metal bowl and 191 

place in the freezer about an hour before heart excision. 192 

 193 

2.1.2. Setup a dissection rig ensuring dissection solution is well-oxygenated (100% oxygen) and 194 

has flushed through each of the tubing lines. Fill the dissection chamber with oxygenated 195 

dissection solution and loosely tie 3/0 suture around the perfusion catheter. 196 

 197 

2.2. Excise the heart. 198 

 199 

2.2.1. Anesthetize 8-10 weeks old Wistar rat using gaseous isoflurane (< 5% in oxygen). Confirm 200 

anesthesia by tail pinching. 201 

 202 

2.2.2. Position the anesthetized rat in a supine position and inject subcutaneously in the 203 

abdominal area with heparin solution (1000 IU/kg). Maintain anesthesia for five more minutes 204 

to allow the heparin to circulate. 205 

 206 

2.2.3. Retrieve the metal bowl containing dissection solution from the freezer and place it near 207 

the euthanization bench. 208 

 209 

NOTE: Avoid freezing the dissection solution completely to enable the complete submersion of 210 

the dissected heart.  211 

 212 

2.2.4. Transfer the anesthetized rat to the euthanization bench and euthanize by cervical 213 

dislocation. 214 

 215 

2.2.5. Open the rat chest with scissors, first cutting the body wall along the underside of the 216 

ribcage, then the diaphragm, before proceeding along the lateral borders of the ribcage. Lift the 217 

chest out of the way. 218 

 219 



2.2.6. Grab the heart with one hand while the other hand uses a pair of curved scissors to cut 220 

the connecting vessels (aorta, vena cava, etc.). 221 

 222 

2.2.7. Quickly submerse the heart in the cold dissection solution. 223 

 224 

2.3. Isolate a trabecula. 225 

 226 

2.3.1. Identify the aorta while the heart is in the metal bowl, then transfer the heart to the 227 

dissection chamber. Using two curved forceps, pull the aorta over the perfusion cannula. 228 

 229 

2.3.2. Hold the aorta in place with one forceps. Meanwhile, open the tubing line to allow the 230 

dissection solution to flow through the perfusion cannula. 231 

 232 

NOTE: Aim to complete perfusion within the minute following the heart excision. 233 

 234 

2.3.3. Once the coronary vasculature is cleared of blood and the heart is completely perfused 235 

with the dissection solution, halt the perfusion flow, and secure the aorta in place using the 236 

suture. Turn the flow back on and perfuse the cannulated heart. 237 

 238 

2.3.4. Rotate the cannula so that the left coronary artery is visible on the superior surface. Pin 239 

the apex of the heart to the bottom of the dissection chamber (Figure 5A). Cut off both atria 240 

(Figure 5B). 241 

 242 

2.3.5. With a set of spring scissors, cut along the right side of the septum to the apex of the 243 

heart (as indicated on Figure 5B). Pin the opened left ventricle to the base of the dissection 244 

chamber. Then cut along the left side of the septum, open the right ventricle, and pin it to the 245 

base of the dissection chamber, too (Figure 5C). 246 

 247 

NOTE: In order to pin the ventricles in an open position, some papillary muscles will have to be 248 

cut. Identify a free-running trabecula in the right ventricle (Figure 5D-E). 249 

 250 

2.3.6. Using the spring scissor and a forceps, cut the wall tissue surrounding the trabecula, then 251 

cut the wall tissue in half orthogonally to the direction of the trabecula. Trim the wall tissue until 252 

its dimension is appropriate for the mounting configuration used. In this case, approximately half 253 

the size of a sesame seed (Figure 5F). 254 

 255 

NOTE: Trabeculae can be dissected from the right and left ventricles, but those from the left are 256 

typically more turbid and less applicable for sarcomere and geometry measurements.  257 

 258 

2.3.7. Leave the excised trabecula in the dissection chamber, continuously superfusing with the 259 

dissection solution. 260 

 261 

3. Experimental protocol 262 

 263 



NOTE: The device13 used for this experiment was built in-house and uses custom control code. 264 

The necessary considerations for the design of a device built to replicate these data are two 265 

independently actuated mounting hooks, a measurement chamber with three optically clear axes 266 

(Figure 3), and an external trigger line that synchronizes the brightfield and OCT cameras with 267 

the stimulator. The PMT voltage and force signal were collected using analog DAQ cards, the 268 

images from the OCT and brightfield microscope were collected using Camera Link frame-grabber 269 

cards, and the stimulus signal was collected using a digital I/O card. Data storage was done offline 270 

using a set of producer consumer loops to maintain temporal alignment. 271 

 272 

3.1. Prepare the cardiomyometer. 273 

 274 

3.1.1. Flush hot (~60 °C) water, distilled water (room temperature), and then superfusate 275 

solution through the measurement chamber. Continuously bubble the superfusate solution with 276 

carbogen. 277 

 278 

3.1.2. Turn on the brightfield microscope illumination source and press F1 to enable capture 279 

(Figure 4A). Manually adjust the downstream hook until it is centered in the brightfield image. 280 

Click Zero Downstream Axis, then Downstream Disabled to enable the motor (Figure 4C). Move 281 

the DS Setpoint [um] slider until the end of the hook aligns with the edge of the default region 282 

of interest.  283 

 284 

3.1.2.1. Re-zero the downstream axis, then move the DS Setpoint [um] slider to 1000. 285 

Repeat the process with the upstream hook, but do not move the US Setpoint [um] slider. 286 

 287 

3.1.3. Click Move to Mounting (Figure 4C). 288 

 289 

3.1.4. Start the fluorescence illumination system by toggling the Lamp switch before quickly 290 

turning on the controller subsystems by toggling the Main switch.  291 

 292 

NOTE: Some UV light sources produce large amounts of ozone. If this is the case, connect an 293 

ozone extractor to the outlet vent of the light source and ensure it is running prior to turning on 294 

the fluorescence illumination source. 295 

 296 

3.1.5. Switch the operational mode to Turbo-Blanking by pressing the Mode button on the front 297 

panel, followed by 2, then 1. Press the On-line button to allow the control code to inform 298 

operation. 299 

 300 

3.2. Mount the trabecula. 301 

 302 

3.2.1. Pause superfusate flow through the measurement chamber. Fill the mounting chamber 303 

with the dissection solution. 304 

 305 

3.2.2. Using a 1 mL syringe, transport the trabecula from the dissection chamber to the 306 

mounting chamber (Figure 5G). 307 



 308 

3.2.3. To transfer the trabecula, place the syringe vertically and in contact with the surface of 309 

the mounting chamber solution. Allow the trabecula to descend into the mounting chamber via 310 

gravity (Figure 5H). 311 

 312 

3.2.4. Lower the fluid level in the mounting chamber so that it is in level with the midsection of 313 

the hooks. 314 

 315 

3.2.5. Adjust the distance between the hooks to reflect the slack length of the trabecula by 316 

moving the DS Setpoint [um] slider. 317 

 318 

3.2.6. Using a microscope to aid visualization, lightly grip one of the pieces of end tissue with 319 

forceps and mount it onto the upstream hook. Mount the other piece of end tissue onto the 320 

downstream hook (Figure 5I). 321 

 322 

3.2.7. Once securely mounted, move the trabecula back into the measurement chamber (Figure 323 

5J) by pressing Move to Chamber (Figure 4C). Resume superfusate flow and fluid extraction. 324 

 325 

3.2.8. Set Stimulus frequency [Hz] to 1, Stimulus duration [ms] to 10, and Stimulus Voltage to 326 

10. Start stimulation by pressing Stimulus On?. 327 

 328 

3.3. Prepare the trabecula. 329 

 330 

3.3.1. After about 1 h of acclimatization, gradually decrease the stimulus voltage and stimulus 331 

duration in 1 V and 1 ms steps, respectively. A typical set of values is 3 V and 3 ms. 332 

 333 

3.3.2. Turn on the brightfield illumination system. Press F1 and select a region of interest that 334 

encloses a striated area on the user-interface. Click Compute SL? to calculate the average 335 

sarcomere length in the highlighted region. Increase the muscle-length until the average 336 

sarcomere length is 2.32 μm by increasing the Separation Setpoint [um] slider. 337 

 338 

NOTE: Compute SL? uses a 2D FFT outlined in Step 4.3. The region of interest used to calculate 339 

the average sarcomere length is typically a 100 μm to 150 μm square. Therefore, as the muscle 340 

approaches optimal sarcomere length, 43 to 65 sarcomeres are used to calculate the average 341 

sarcomere length. 342 

 343 

3.3.3. Move the muscle by adjusting the Centre Setpoint [um] slider on the “Centre and 344 

Separation Control tab (Figure 4C) so that the edge of the downstream hook is just visible within 345 

the brightfield image. Collect the fluorescence information for ten twitches. 346 

 347 

3.3.4. Increase the Centre Setpoint [um] value by 200 and collect another ten twitches worth 348 

of fluorescence information. Repeat this process until the brightfield image contains the 349 

upstream hook. Collect the final window’s worth of fluorescence information. 350 

 351 



3.3.5. Return the trabecula to a central position by setting the Centre Setpoint [um] value to 0. 352 

 353 

3.3.6. Reduce the stimulus frequency to 0.2 Hz and switch from the KH superfusate to the Fura-354 

2 loading solution (detailed in Table 1). 355 

 356 

3.3.7. Measure the fluorescence signal every 10 min by clicking Enable Fluorescence Source on 357 

the Stim and Data tab. Visualize the fluorescence signal on the PMT Signal tab. 358 

 359 

3.3.8. After the 360 nm signal has increased by a factor of 10 or the duration of the loading 360 

procedure has exceeded 2 h, return the stimulus frequency to 1 Hz and switch back to the KH 361 

superfusate solution. 362 

 363 

3.3.9. Check the ratio measurement every 10 min until the ratio measurement stabilizes, at 364 

which point data collection can begin. 365 

 366 

3.4. Collect brightfield- and fluorescence-imaging data. 367 

 368 

3.4.1. Return the muscle to the position where the edge of the downstream hook is just present 369 

within the brightfield image. Start streaming hardware data by clicking Stream Data to Disk on 370 

the Stim and Data tab of the hardware-control user interface. Capture fluorescence information 371 

by clicking Enable Fluorescence Source. 372 

 373 

3.4.2. On the brightfield imaging user interface, set the capture mode to an external trigger, 374 

increase the frame rate to 100 Hz, and set the number of images to capture to 100. Press Ctrl + 375 

Shift + S followed by F1 to record the brightfield imaging data for this window. 376 

 377 

3.4.3. Increase Centre Setpoint [um] value by 200 and repeat Step 3.4.2. Continue with the 378 

scanning protocol until the imaging data has been collected for the final window from Step 3.3.4. 379 

 380 

3.4.4. Return the trabecula to a central position by setting the Centre Setpoint [um] value to 0. 381 

 382 

3.5. Collect OCT imaging data. 383 

  384 

3.5.1. Turn on the OCT laser source by turning the master key to the | symbol, pressing the 385 

power button, followed by the SLDs button. 386 

 387 

3.5.2. Cover the galvanometer head and click Get BG to measure the background interference 388 

pattern and subtract it from the measurement (Figure 4B). 389 

 390 

3.5.3. Set the image capture mode to live-view. 391 

 392 

3.5.4. Adjust the y-position until the B-scan image contains the upstream hook only. Divide the 393 

muscle length displayed on the control front panel (Figure 4B) by two and subtract the current 394 



y-position. Enter this value into the “y-offset” input. Adjust the “x-offset” value until the cross-395 

section of the trabecula is centered in the frame. 396 

 397 

3.5.5. With the trabecula centered, scan along the y-axis by adjusting the y-position to find the 398 

positions corresponding to the upstream and downstream hooks. Note these positions down. Set 399 

Range Y (steps) to the absolute difference between these values divided by ten. 400 

 401 

3.5.6. Set the image capture mode to Stimulus Triggered?, Range X (steps) to 100, and click the 402 

Set Active Parameters button.  403 

 404 

3.5.7. Click Stream B-Scan Data?, then Acquire.  405 

 406 

NOTE: The gated imaging protocol requires 200 twitches to capture the entire muscle geometry 407 

for a sample 2 mm in length, which corresponds to a capture time of ~3 min 20 s. 408 

 409 

4. Process the brightfield image dataset 410 

 411 

4.1. Prepare the images for analysis. 412 

 413 

4.1.1. Import images into ImageJ (File > Import > Image Sequence > Select image). 414 

 415 

4.1.2. Increase image contrast (Image > Adjust > Brightness/Contrast > Move minimum and 416 

Maximum sliders to centralize the image histogram). 417 

 418 

4.1.3. Sharpen the images (Process > Filters > Unsharp Mask > set Radius (Sigma) to 1.0 pixels 419 

and Mask Weight (0.1-0.9) to 0.6). 420 

 421 

4.1.4. Export the image sequence (Save As > Image Sequence > Set the Format to PNG, Start at 422 

to 0 and Digits (1-8) to 4). 423 

 424 

4.2. Stitch the images, measure the localized displacement, and compute the local sarcomere 425 

lengths. 426 

 427 

4.2.1. Open “TrabeculaProcessing.m” (available on request) and set the FolderPath variable to 428 

the main folder containing all of the data, and ImagePath to the folder where the image sequence 429 

from Step 4.1.4 was saved. Set sections to the number of imaging windows and frames to the 430 

number of frames captured per window. 431 

 432 

4.2.2. Run the code. 433 

 434 

NOTE: The outputs will be present in the output folder path specified by the user. (By default, 435 

the path is set to FolderPath/Output). 436 

 437 

4.3. FFT sarcomere length technique 438 



 439 

4.3.1. Use image-processing software to perform a FFT on a region of the image where 440 

sarcomeres are highly visible. 441 

 442 

4.3.2. Multiply the pixels per μm calibration results from Step 1.1.6 by 1.6 μm and 3.0 μm before 443 

calculating the inverse to get the range of spatial frequencies of interest. 444 

 445 

4.3.3. Fit an exponential to the FFT result, ignoring the frequency information in the frequency 446 

range calculated in Step 4.3.2, and subtract it from the transform result to remove the DC term. 447 

 448 

4.3.4. Fit a Gaussian curve to the frequency band of interest. 449 

 450 

4.3.5. Calculate the inverse of the peak of the Gaussian curve. This is the average sarcomere 451 

length for the region of interest. 452 

 453 

NOTE: The FFT calculation and the fitting of the exponential and Gaussian equations were 454 

performed using custom LabVIEW code. 455 

 456 

5. Process the fluorescence data 457 

 458 

5.1. Subtract the window-dependent autofluorescence from the respective window and 459 

compute the quotient of the signals associated with the 340 nm and 380 nm excitation 460 

wavelengths.  461 

 462 

6. Process the OCT imaging data 463 

 464 

6.1. Prepare the OCT image set for segmentation. 465 

 466 

6.1.1. Open ImageJ and import the images (File > Import > Image Sequence). On the file 467 

explorer window, this opens, locate the images, select one and click Open. 468 

 469 

NOTE: If the control code for the OCT does not store the images in a format that is readable by 470 

ImageJ, convert them to PNG. 471 

 472 

6.1.2. To ease visualization, organize the image sequence into a hyperstack (Image > 473 

Hyperstacks > Stack to Hyperstack). In the dialogue box that opens, set the number of slices to 474 

the number of B-scans per slice and the X to the number of slices along the length of the 475 

trabecula. 476 

 477 

6.1.3. Draw a rectangle that encloses the trabecula. Confirm that it encloses the entire volume 478 

through time by using the sliders on the hyperstack window. Crop the image to the window 479 

(Image > Crop). 480 

 481 



6.1.4. Remove slices that contain images of the mounting hooks (Stacks > Tools > Slice Keeper). 482 

Select the range of slices that contains trabecula information only. 483 

 484 

6.2. Train WEKA segmentation. 485 

 486 

6.2.1. Open WEKA segmentation (Plugins > Segmentation > Trainable Weka Segmentation). 487 

 488 

6.2.2. Set the selection mode to Freehand. 489 

 490 

6.2.3. Click Settings and adjust the classifier and training settings. (For this model, the following 491 

Training features were used: Gaussian blur, Sobel filter, Hessian, Difference of Gaussians, 492 

membrane projections, Bilateral, and Lipschitz. Membrane thickness was set to 1, Membrane 493 

patch size to 8, Minimum sigma to 1, and Maximum sigma to 32. The classifier was set to 494 

FastRandomForest and the classifier options were set to: batchSize 100, maxDepth to 32, 495 

numFeatures to 32, numThreads to 0, and numTrees to 200.) 496 

 497 

6.2.4. Manually segment images until training results in satisfactory segmentations.  498 

 499 

6.2.5. Save the classifier. 500 

 501 

6.3. Segment the processed B-scans 502 

 503 

6.3.1. Launch WEKA segmentation following Step 6.2.1. 504 

 505 

6.3.2. Load the classifier from Step 6.2.5. 506 

 507 

6.3.3. Click Create Result. 508 

 509 

6.3.4. Convert the images to 8-bit (Image > Type > 8-bit). 510 

 511 

6.3.5. Convert the images to binary (Process > Binary > Make Binary > Default method and 512 

default background). 513 

 514 

6.3.6. Save as image sequence (PNG). 515 

  516 

6.4. Calculate the average CSA in the segmented B-scan images. 517 

 518 

6.4.1. Count the number of white pixels in a binary B-scan image. 519 

 520 

6.4.2. Multiply the pixel area by the calibrated depth resolution (from Step 1.2) and 10 μm (the 521 

distance between neighboring A-scans). 522 

 523 

6.4.3. Repeat for all of the B-scans between the hooks and average the measurements. 524 

 525 



6.5. Convert segmented image into a mesh. 526 

 527 

6.5.1. Open “OCTmain.m” (available on request) and set imageDirectory to the folder containing 528 

the output from Step 6.3.6. Set outputPath as necessary. 529 

 530 

6.5.2. Set slices to the value of “Range Y (steps)” (Step 3.5.5) and frames to the value of “Repeat 531 

X” (Step 3.5.6), z_dim to the depth resolution (Step 1.2.10), and x_dim & y_dim to the value 532 

assigned to 10. 533 

 534 

6.5.3. Click Run. 535 

 536 

REPRESENTATIVE RESULTS: 537 

In order to capture the regional Ca2+ and brightfield information for the entire length of the 538 

trabecula presented here, seven muscle positions were required. Figure 6 suggests that the 539 

twitch force was undisturbed by this motion, revealing that there was no position dependence 540 

of the active force production. 541 

 542 

B-scans collected using optical coherence tomography at a rate of 100 Hz were segmented using 543 

the ImageJ plugin WEKA14 (Figure 7A). Each cross-section appears distorted due to the difference 544 

between the lateral (10 μm) and depth (1.73 μm (in myocardium)) resolutions. This distortion 545 

was corrected by scaling the image's depth axis by the lateral resolution-depth resolution ratio. 546 

Figure 7B,C demonstrate that after scaling the raw C-scan of the trabecula it is approximately 547 

cylindrical in geometry. The reflection of the measurement chamber wall can sometimes overlap 548 

with the muscle data (Figure 7A,B), but the segmentation software can be trained to account for 549 

this (Figure 7D,E). Once segmented, the cross-sectional area along the length of the muscle can 550 

be calculated throughout the twitch (Figure 7F). Note that this particular trabecula has a small 551 

appendage branching from it. The motion of the branch is evident ~0.75 mm along the trabecula. 552 

Finally, the segmented images can be converted into meshes to aid the construction of 553 

geometrical models (Figure 7G). 554 

 555 

Imaging data captured at each of the different trabecula positions at a rate of 100 fps were 556 

stitched together to create a single complete image of the trabecula (Figure 8A). The resolution 557 

of these images is 0.535 μm/pixel. The use of linear weighting functions in the overlapping 558 

regions of neighboring windows aids visualization and minimizes the impact of the vignette 559 

present in the brightfield images. To measure the fluorescent signal, a 540 μm by 540 μm window 560 

of the trabecula is cyclically illuminated with 340 nm, 365 nm, and 380 nm wavelength light at a 561 

rate of 600 Hz. The ratio of the emitted fluorescence associated with the 340 nm and 380 nm 562 

excitation light correlates to the intracellular calcium after the trabecula has been loaded with 563 

Fura-2. As this measurement is a ratio, the effective measurement rate is 200 Hz. The averaged 564 

(n = 10) intracellular Ca2+ transients from each window are aligned with the region they were 565 

imaged (Figure 8B). While the peak of the transients appear reasonably consistent, the diastolic 566 

[Ca2+] is lower within the region between 900 μm and 1800 μm along the trabecula. Similarly, the 567 

results of the displacement tracking (Figure 8C) and sarcomere length (Figure 8D) calculations 568 

also indicate the presence of regional variability. The markerless tracking technique used is able 569 



to process the displacement of each pixel, given enough contrast. When mapping the distribution 570 

of sarcomere lengths in post, a cross-correlation area of 128 pixels by 128 pixels (~67 μm by 67 571 

μm) was used to calculate regional sarcomere length. This area encapsulates approximately 29 572 

sarcomeres when close the sample is close to optimal sarcomere length. The step-size (in both 573 

the x- and y-directions) between the centroid of each cross-correlation window was set to 50 574 

pixels (~26 μm) for processing these data. The suitability of sarcomere length estimates were 575 

tested based on the width and amplitude of the Gaussian fit to the FFT signal. These conditions 576 

were not met in the muscle region between 0 μm and 500 μm so no sarcomere length 577 

information could be computed there. Given the associated displacements, it is likely that the 578 

sarcomeres in this region elongated during the contractile phase. In keeping with this 579 

speculation, the average sarcomere lengths on the right-hand side of the trabecula shorten 580 

during that period. By combining the information provided by each of the panels it appears that 581 

the region with the largest cross-sectional area does not produce the most significant force. On 582 

the assumption that the regional variation of Ca2+ transients has an approximately smooth 583 

gradient, Figure 8B indicates that the largest amplitude Ca2+ transient occurs somewhere 584 

between 1300 μm and 1600 μm along the trabecula. The displacement map indicates that the 585 

region that undergoes the least motion aligns well with the peak Ca2+ transient. However, this 586 

region has the smallest cross-sectional areas of the sample. With these data in mind, one could 587 

infer that this region generated the most stress. 588 

 589 

FIGURE LEGENDS 590 

Figure 1: Annotated image of the cardiomyometer. Each of the main optical components is 591 

outlined. The inset contains a close-up, rear-view, of the microscope objective in situ, below the 592 

measurement chamber.  593 

 594 

Figure 2: Optical pathway for simultaneous brightfield and fluorescence microscopy. The 595 

illumination source for the fluorescence microscope is a Xenon arc lamp, the output of which 596 

cyclically switches between 340 nm, 365 nm, and 380 nm light. The arc lamp output path 597 

contains a dichroic mirror with a cut-off wavelength of 409 nm that reflects the UV light onto a 598 

mirror that directs the light into a fluorescence microscope objective. The lens focuses the 599 

excitation light onto the sample and collects the emitted light, which has a longer wavelength of 600 

510 nm. This emitted light passes through the first dichroic mirror, but not the second, as it has 601 

a cut-off wavelength of 552 nm. A field lens then focuses the reflected light onto the sensor of 602 

the PMT. Meanwhile, the illumination source (660 nm LED) for the brightfield microscope is 603 

located above the sample. The transmitted light is focused onto the sample by a condenser lens, 604 

and the 20× fluorescence objective captures the resultant transmission image. The wavelength 605 

used for brightfield illumination exceeds the cut-off wavelength of each dichroic mirror, so it 606 

passes through both of them before the image is focused onto the sensor of a CMOS camera. 607 
 608 

Figure 3: Measurement chamber holder design. (A) Isometric view of the measurement chamber 609 

holder with optical paths overlaid. Brightfield illumination occurs from the superior surface (z-610 

axis); fluorescence illumination occurs from the inferior surface (z-axis), and the measurement 611 

arm OCT signal is orthogonal to the other illumination axis (y-axis). During the experiment, two 612 

platinum hooks hold a trabecula within a glass capillary tube that functions as the measurement 613 



chamber. Voice-coil motors control each hook and their positions are measured using laser 614 

interferometry. The current position is compared with a user-defined set point and, using a PID 615 

controller encoded within an FPGA, the error is minimized. (B) Measurement chamber in situ 616 

with the brightfield illumination turned on. The back-view is shown in the Figure 1 inset. (C) 617 

Schematic of the superfusate flow through the measurement chamber holder. Superfusate 618 

enters the rear of the block and flows in the direction indicated by arrows. The upstream and 619 

downstream electrodes establish the field stimulation for eliciting the contraction of a mounted 620 

trabecula in the measurement chamber. Blue shading indicates the regions where the 621 

superfusate flows during an experiment. 622 
 623 

Figure 4: Front panel of the image acquisition and control software. (A) Brightfield imaging user 624 

interface. (B) OCT imaging user interface. (C) Hardware control user interface. 625 

 626 

Figure 5: Trabecula dissection and mounting protocol. (A) Langendorff-perfused rat heart in the 627 

dissection chamber. (B) The same heart with the atria removed. Dashed lines indicate the 628 

excision trajectory to open the ventricles. (C) An opened heart to expose the interior of both 629 

ventricles. The dashed box indicates the region where trabeculae are typically found. (D) Excised 630 

right-ventricular wall region (the same as indicated by the dashed box in C). Dashed lines highlight 631 

three trabeculae. (E) A trabecula selected from the three in D. (F) The trabecula from panel E with 632 

the wall tissue removed. (G) The isolated trabecula in the end of a 1 mL syringe. (H) The trabecula 633 

in the mounting chamber. (I) The trabecula mounted between two platinum hooks. (J) The 634 

trabecula, mounted between hooks, within the measurement chamber (Figure 3B). The green 635 

spot is an artefact from the first dichroic filter. (K) Secondary angle of the mounted trabecula 636 

within the measurement chamber. The distance between the trabecula and the microscope 637 

objective lens is approximately 1 mm.  638 

 639 

Figure 6: Position dependence of the force measurement. The force produced by the muscle 640 

from each of the imaging positions (n = 7) overlaid. The average active force production was 641 

0.527 mN ± 0.003 mN, time to 50 % contraction 77.1 ms ± 0.3 ms, and time to 50 % relaxation 642 

328.1 ms ± 0.9 ms (all data are presented as the mean ± SE). 643 

 644 

Figure 7: OCT imaging analysis. (A) Example of WEKA segmentation. The segmented cross-645 

section of the muscle is highlighted in red, and the background is highlighted in green. (B) 646 

Superior view of the raw C-scan data of a trabecula. The bright angled line towards the top of the 647 

image is the reflection of the measurement chamber wall. (C) Lateral view of the raw C-scan data 648 

of a trabecula. (D) Superior view of the segmented OCT data. (E) Lateral view of the segmented 649 

OCT data. (F) The cross-sectional area along the length of the trabecula (x-axis) through time (y-650 

axis). The average cross-sectional area along the muscle length was 32.6 mm2 ± 0.5 mm2 (mean 651 

± S.E.) (G) A mesh of the trabecula. The mesh has been approximately aligned with the cross-652 

sectional area plot of panel F. 653 

 654 

Figure 8: Brightfield and fluorescence imaging analysis. (A) Stitched image (seven imaging 655 

windows) of the trabecula. (B) Ca2+
 transients along the length of the trabecula. (C) Average x-656 

displacement from each imaging window. A positive displacement represents a motion to the 657 



right and negative to the left. (D) Average sarcomere lengths from each imaging window that had 658 

the necessary image contrast.  659 

 660 

Table 1: Table of Solution 661 
 662 

DISCUSSION  663 

In this study, we present a configuration that enables the assembly of three optical systems 664 

combining a brightfield, fluorescence, and OCT imaging to gather data from an actively 665 

contracting ex vivo cardiac trabecula (Figure 1 and Figure 2). Such an orchestrated integration is 666 

possible due to the design of the measurement chamber (Figure 3) to enable the orthogonal 667 

arrangement of the OCT to the brightfield-fluorescence axis. The muscle‑mounting system plays 668 

an equally important role in the success of simultaneous quantifications of key indices in 669 

characterizing cardiac muscle excitation‑ contraction dynamics. Its novelty resides in enabling 670 

muscle-scanning procedures with no apparent disturbance to the mechanical performance of the 671 

muscle (Figure 6). With the combined imaging configuration and motorized-hook system for 672 

force measurement, this system can evaluate regional heterogeneity in the Ca2+ transient, 673 

displacement, and sarcomere length, together with macroscopic geometric information of a 674 

contracting trabecula throughout the time-course of the twitch (Figures 7 and Figure 8). 675 

 676 

Given the ubiquity of brightfield-epifluorescence imaging systems within cardiac research 677 

laboratories, the reproduction of these results can be achieved with some minor hardware 678 

considerations. Here, we present the image-processing toolkit for combining brightfield-679 

epifluorescence and OCT, which is essential in analyzing the underlying contractile heterogeneity. 680 

The integration of the OCT requires an unobstructed optical path, while the gated imaging 681 

requires an external trigger line between the stimulus and both the OCT and brightfield imaging 682 

camera, and muscle mounting hooks that are capable of moving the sample throughout the 683 

measurement chamber. The required post-processing software and methods are freely available. 684 

In particular, the segmentation software used, WEKA14, is open-source. The technique of 685 

markerless tracking of material points8, sarcomere length, gated volumetric imaging10, and mesh 686 

generation codes are likewise accessible and can be made available on request from the 687 

corresponding author. 688 

 689 

Muscle viability, optimal loading of Fura‑2, and image focus are the three pillars that form the 690 

foundations of a successful experiment. Using a dissection solution containing BDM to prevent 691 

contracture, transportation of the muscle in a syringe, continuous oxygenation of the solution, 692 

and preparing new experimental solutions on the day of an experiment, all contribute to a high 693 

muscle viability rate. Before loading the trabecula with Fura-2AM, autofluorescence must be 694 

collected for each condition one is interested in studying as it can have a significant effect on the 695 

measured Ca2+ transient15. Oxygenation of Fura-2AM loading solution is complicated by the 696 

necessary inclusion of the surfactant pluronic-F127 to aid dye loading. To combat the resultant 697 

excess bubble formation caused by this surfactant, a small drop of anti-foam in the loading 698 

solution allows the user to increase the oxygenation rate, thereby improving the chance that the 699 

trabecula maintains functional viability throughout the loading process. Finally, the imaging focus 700 



must be uniform along muscle length to maximize the signal to noise ratio of the brightfield and 701 

fluorescence information.  702 

 703 

There are two limitations to consider with the methods presented here. First is the spatial 704 

resolution of the fluorescence microscope. While the spatial resolutions of the OCT and 705 

brightfield imaging are high, the resolution of the fluorescence microscope is limited to the 706 

integral of the fluorescence from the volume captured within a 540 μm by 540 μm imaging 707 

window. There is scope to increase the spatial resolution of the fluorescence microscope by using 708 

a high-gain charge-coupled device camera, instead of a PMT, to capture the fluorescence signal 709 

at the expense of the signal to noise ratio16. Second is the diameter of the trabecula that can be 710 

studied in terms of measurable sarcomere length and geometrical depth. The windowed-FFT 711 

approach for computing sarcomere length exploits the benefit of improved spatial resolution but 712 

is associated with reduced robustness (Figure 8D). In cases where turbid or large-diameter 713 

trabeculae are to be studied, the resolvability of the FFT will be greatly reduced due to the 714 

reduced contrast associated with the sarcomeric banding in larger tissue samples. Likewise, 715 

within the OCT, the back-reflections from an imaging depth of greater than 300 μm will be too 716 

weak to be resolved during the segmentation stage. Hence, our technique is limited to trabeculae 717 

of a diameter less than 300 μm. However, it is not recommended to study large diameter samples 718 

as there may be problems with diffusive oxygenation of the muscle core during high rates of 719 

stimulation17. 720 

 721 

Our method enables the assessment of ionic-mechanical function in association with muscle 722 

geometry in healthy and diseased muscle, providing a powerful approach to understanding 723 

cardiac muscle physiology, pathophysiology, and pharmacology. The image-processing pipeline 724 

outlined here extracts data that will be pivotal for garnering a deeper understanding of 725 

contractile heterogeneity. One avenue to fully realize the potential of such a rich dataset is in the 726 

construction of mathematical models that integrate and interpret these data, and to make 727 

predictions that can be tested experimentally using our device. 728 
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Figure 4: Front panel of the image acquisition and control software Click here to access/download;Figure;Figure 4.pdf
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Figure 5: Trabecula dissection and mounting protocol Click here to access/download;Figure;Figure 5.pdf
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Figure 6: Position dependence of the force measurement Click here to access/download;Figure;Figure 6.pdf
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Figure 8: Brightfield and fluorescence imaging analysis Click here to access/download;Figure;Figure 8.pdf
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Molar mass 

(g/mol)

Concentration 

(mmol/L)

Mass to add to 1 L 

distilled water (g)

NaCl 58.44 1300 75.972

KCl 74.5513 60 4.473078

MgCl2 95.211 10 0.95211

NaH2PO4.2H2O 156 5 0.78

HEPES 238.3012 100 23.83012

Molar mass 

(g/mol)

Concentration 

(mmol/L)

Mass to add to 1 L 

distilled water (g)

NaCl 58.44 590 34.4796

KCl 74.5513 23.75 1.770593375

MgSO4.7H2O 246.47 5.9 1.454173

KH2PO4 136.086 5.9 0.8029074

NaHCO3 84.007 124 10.416868

Molar mass 

(g/mol) 

Concentration 

(mmol/L)

Mass to add to 0.1 L 

distilled water (g)

CaCl2 110.98 1000 11.098

Molar mass 

(g/mol)

Concentration 

(mmol/L)

Mass to add to 1 L 

distilled water (g)

TRIS 121.14 1000 121.14

NOTE: All of the above stock solutions can be made prior to the day of the experiment. Store at 4 oC.

Molar mass 

(g/mol)

Concentration 

(mmol/L)

Mass to add to 30 uL 

DMSO (ug)

Fura-2AM 1001.861 3.327 100

NOTE: Warm the DMSO before adding it to the fura-2AM. Make stock on the day of the experiment.

Fura-2AM stock solution

Tyrode's stock solution (10x)

Krebs-Henseleit (KH) stock solution (5x)

CaCl2 stock solution

TRIS stock solution
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Molar mass (g/mol) Concentration (mmol/L)

BDM 101.104 20

Glucose 180.16 10

Tyrode's stock solution - -

CaCl2 stock solution - 0.3

TRIS stock solution - -

Molar mass (g/mol) Concentration (mmol/L)

Glucose 180.16 10

KH stock solution - -

CaCl2 stock solution - 1.5

 NOTE: Bubble superfusate solution with carbogen before adding CaCl2 stock solution

Fura-2 loading solution

Volume to add (mL)

Fura-2AM stock solution 0.03

Powerload 100x concentrate 0.1

Superfusate solution 9.87

NOTE: Use a pin to add a drop of antifoam A concentrate to the loading solution

NOTE: Prepare these solutions on the day of experiments

Dissection solution

Superfusate solution



Mass to add to 1 L (g) Volume to add to 1 L (mL)

2.0222 -

1.8018 -

- 100

- 0.3

- Add until pH is 7.4

Mass to add to 1 L (g) Volume to add to 0.25 L (mL)

0.4505 -

- 50

- 0.375

Dissection solution

Superfusate solution
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Response to reviewers 

Thank you for your insightful feedback. We believe that we have addressed all of the key 

concerns raised. In the rare case that a concern was not addressed by an amendment to the 

text, we have provided a brief justification. Any edits to the previous submission have been 

highlighted in red. 

Editorial and production comments: 

1. Please take this opportunity to proofread the manuscript thoroughly to ensure that there 

are no spelling or grammar issues. 

We have proofread the manuscript thoroughly. 

2. Please format the manuscript as: paragraph Indentation: 0 for both left and right and 

special: none, Line spacings: single. Please include a single line space between each step, 

substep and note in the protocol section. Please use Calibri 12 points. 

The manuscript has been re-formatted accordingly. 

3. Please provide an email address for each author. 

Jarrah Dowrick: j.dowrick@auckland.ac.nz 

Alex Anderson: elegantgrooves@gmail.com  

Ming Cheuk: ming.cheuk@spark64.com  

Kenneth Tran: k.tran@auckland.ac.nz  

Poul Nielsen: p.nielsen@auckland.ac.nz  

June-Chiew Han: j.han@auckland.ac.nz  

Andrew Taberner: a.taberner@auckland.ac.nz  

4. Please rephrase the Short Abstract/Summary to clearly describe the protocol and its 

applications in complete sentences between 10-50 words: “This protocol presents…” 

The Short Abstract/Summary has been re-phrased to “This protocol presents …”. 
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5. Please ensure that all text in the protocol section is written in the imperative tense as if 

telling someone how to do the technique (e.g., “Do this,” “Ensure that,” etc.). The actions 

should be described in the imperative tense in complete sentences wherever possible. 

Avoid usage of phrases such as “could be,” “should be,” and “would be” throughout the 

Protocol. Any text that cannot be written in the imperative tense may be added as a 

“Note.” 

Text that could not be written in the imperative tense were added as “notes”. We have 

rephrased or removed all instances of phrases such as “could be”, “should be”, and “would 

be” throughout the protocol section. 

6. Please ensure you answer the “how” question, i.e., how is the step performed? 

We have restructured the protocol section to ensure that the how question is answered. In 

some cases, the level of detail was increased to make the steps involved clearer. 

7. Solution preparation details can be moved to a table and uploaded separately as .xlsx file. 

We have removed the solution preparation details from the protocol section and moved 

them into a file called “Tables_of_solutions.xlsx”. 

8. There is a 10 page limit for the protocol section including headings and spacings. 

The protocol complies with this limit. 

9. Please ensure the results are described in the context of the presented technique. e.g., 

how do these results show the technique, suggestions about how to analyze the outcome, 

etc. The paragraph text should refer to all of the figures. Data from both successful and 

sub-optimal experiments can be included. 

We have included new figures (Figures 1, 3B, and 4), and have largely revised the result texts 

and figure captions. 

10. Please ensure all figures are referenced in the order. Please discuss all figures in the 

Representative Results. However, for figures showing the experimental set-up, please 

reference them in the Protocol. 



We have checked that all figures have been referenced in order. The figures that show the 

experimental set-up are now referenced in the protocol section. 

 

11. Please obtain explicit copyright permission to reuse any figures from a previous 

publication. Explicit permission can be expressed in the form of a letter from the editor or 

a link to the editorial policy that allows re-prints. Please upload this information as a .doc 

or .docx file to your Editorial Manager account. The Figure must be cited appropriately in 

the Figure Legend, i.e. “This figure has been modified from [citation].” 

All figures used within this article are original and generated specifically for it. 

12. JoVE cannot publish manuscripts containing commercial language. Please remove all 

commercial language from your manuscript and use generic terms instead. All commercial 

products should be sufficiently referenced in the Table of Materials and Reagents. For 

example: Nikon, etc. 

We have removed all mentions of commercial language within the main body of the 

manuscript. 

13. Each Figure Legend should include a title and a short description of the data presented in 

the Figure and relevant symbols. The Discussion of the Figures should be placed in the 

Representative Results. Details of the methodology should not be in the Figure Legends, 

but rather the Protocol. 

The figure legends have been edited to comply with these stylistic guidelines. 

14. Please sort the materials table in alphabetical order.  

The materials table has now been sorted in alphabetical order based on the Name of 

Material/ Equipment column. 

  



Changes to be made by the Author(s) regarding the video: 

1. Please increase the homogeneity between the video and the written manuscript. Ideally, 

all figures in the video would appear in the written manuscript and vice versa. The video 

and the written manuscript should be reflections of each other. 

The figures included in the video have been changed to increase the homogeneity between 

the video and the written manuscript. 

 

2. Furthermore, please revise the narration to be more homogenous with the written 

manuscript. Ideally, the narration is a word for word reading of the written protocol. 

We re-wrote the script and recorded new narration so it is essentially a word for word 

reading of the written protocol. 

 

3. Currently both the text and the video have different order of steps presented in the 

protocol text. There can be steps in the text that are not presented in the video however. 

The order of the steps presented in the video have been adjusted to reflect the order of 

steps in the text. 

 

4. Please ensure that the protocol subheadings are the same both in the text and the video 

We have modified the protocol subheadings in the text and the video so that they are 

aligned. 

 

5. Video Editing: 

a. Needs an animal ethics card at the end of the introduction section before the protocol 

An animal ethics card has been added at the end of the introduction section of the 

video. 

b. Please include a title card at the end of the video as well. 

We have included the opening title card at the end of the video as well.  



Reviewer 1 comments: 

Major Concerns: 

No major concerns 

Minor Concerns: 

Some minor revisions can be made to further improve the quality of the manuscript and the 

video. 

1. The force and length-control equipment are custom but they could be briefly detailed in 

the manuscript. 

A brief description of the custom force and length-control equipment has been added to the 

caption of Figure 3.  

 

2. The representative results are for an isometric twitch contraction. If a length ramp is 

imposed, sarcomere movement is expected to be greater and maybe faster than for the 

isometric case. Is the device still working for such protocols? In other words, what are the 

required experimental conditions to keep a good resolution for the calcium and muscle 

imaging? 

The temporal resolution of each imaging system is independent of any length control applied 

to the muscle. The rate of tissue movement is not an issue for the calcium imaging system. 

However, there would be limitations with the brightfield imaging if the length ramp had a 

high velocity. For the post-processing steps, images must have sufficient contrast. Should the 

applied ramp result in a high material point velocity, motion blur could restrict the possibility 

to perform image registration. The minimum exposure time of our camera is 3.193 ms at a 

frame rate of 100 fps. At a velocity of *3.1 mm/s, features would move by 18.48 pixels 

(~9.90 μm) during a single exposure. To test the impact on the image registration process, 

we applied motion blur of 19 pixels in length to an image of a diffraction grating 

(500 lines/mm) and displacing it by 19 pixels. This displacement was detectable without 

error using the image registration code (image below). While this amount of motion blur 



would eliminate the possibility of directly measuring sarcomere length using FFTs, previous 

work from our group1 has used these displacement measurements to determine the local 

strain field and found a strong correlation between strain and sarcomere length. 

  

 
*This velocity was the peak shortening velocity reported in a previous publication2. 

1. Cheuk, M.L., Lam Po Tang, E.J., HajiRassouliha, A., Han, J.C., Nielsen, P.M.F., Taberner, 

A.J. A Method for Markerless Tracking of the Strain Distribution of Actively Contracting 

Cardiac Muscle Preparations. Experimental Mechanics. 61 (1), 95–106, doi: 10.1007/s11340-

020-00646-w (2021). 

2. Garrett, A.S., Pham, T., Loiselle, D., Han, J.C., Taberner, A. Mechanical loading of isolated 

cardiac muscle with a real-time computed Windkessel model of the vasculature impedance. 

Physiological Reports. 7 (17), e14184, doi: 10.14814/phy2.14184 (2019). 



 

3. How many sarcomeres (roughly) fit in the window used to image and average the 

sarcomere length? This information can probably be calculated from the data provided in 

the manuscript but it would help the reader to directly access this information. This will 

also quantify the level of heterogeneity the device is able to measure. 

For the sarcomere length calculation performed during in the experiment, the user 

determines the window size. A typical window would be a 100 μm to 150 μm square 

meaning approximately 43 to 65 sarcomeres fit in the window when close to optimal 

sarcomere length.  

When mapping the distribution of sarcomere lengths in post, a cross-correlation area of 

128 pixels by 128 pixels (~67 μm by 67 μm) was used to calculate regional sarcomere length. 

This area encapsulates approximately 29 sarcomeres when the sample is close to optimal 

sarcomere length. The user can change this parameter. The step-size (in both x- and y-

directions) between the centroid of each cross-correlation window is also under user 

control. The step-size parameter was set to 50 pixels (~26 μm) for processing these data. 

We have added this information to the representative results section. 

 

4. Which software/code is used for FFT and exponential/Gaussian fitting? (section 5.1.3) 

For the in-experiment setting of muscle length, the code is custom-written LabVIEW 

(following the algorithm outlined in reference 6). We have added a note to clarify this in 

what is now Section 4.3. 

 

5. For the author video, maybe the portion between 8min21 and 9min can be made clearer, 

as the galvanometer parameters described (such as X range) are not cited in section 4.6 of 

the manuscript. Furthermore, it is unclear to me how the position of the centre of the 

trabeculae is calculated before setting the x and y offset values. 

We have now updated the protocol in Step 3.5.4 of the manuscript and provided a method 

to centre a trabecula in the written submission. 



 

Reviewer 2 comments: 

Major Concerns: 

1. I could not see any description about the data acquisition part (hardware details) in the 

manuscript. How did they acquire three distinct signals from the combined system? Did 

they use three separate analog channels? Which data QAQ has used for this? Need a 

comprehensive detail of these information. 

Added a description of the data acquisition system to the paragraph at the start of Section 3 

of the protocol. We have also updated the descriptions of the DAQ cards used in the tables 

of materials for clarity. 

2. Section 2.2, It is not fully clear how did authors calibrate OCT depth signal in 

Micrometers? Didn't they used the refractive index of the tissue for the pixel calibration? 

If yes, what is the value of refractive index chosen, and why? Need a detailed 

explanation. 

The steps involved in calculating the depth resolution have been modified to improve clarity 

(Section 1.2). Better justification regarding the selection of refractive indices has also been 

included in Step 1.2.9. The refractive index of the tissue was found in a paper studying the 

refractive index of muscles from various mammals (reference 12 in the paper).  

3. Authors need to provide the temporal resolution of the acquisition of each modality and 

together? What is the frame rate for each modality? Need to provide the temporal and 

spatial resolution in each case. 

Brightfield image: 100 Hz, 0.535 μm/pixel 

OCT: B-scan rate 100 Hz, lateral resolution: 10 μm, depth resolution (in air): 2.42 μm, (in 

myocardium) 1.73 μm 

Fluorescence imaging: 200 Hz, PMT integrates the fluorescence associated with a 540 μm by 

540 μm window. 



These values have been added to the contents of the representative results. 

4. Authors should provide the schematic and photograph of the combined tri-modal 

system. 

Figures 1 and 2 within the original submission were supposed to function as the schematic of 

the combined tri-modal system. The new Figure 1 is now a photograph highlighting the 

combined tri-modal system. We have also added an additional photographic panel to what is 

now Figure 3 (Figure 2 in the original submission). 

5. Need to provide the screen shot of the front panel of the image acquisition and control 

software. 

A screenshot of the primary front panels of the custom-made image acquisition and 

hardware-control code software has been added to the manuscript as the new Figure 4. 

6. Authors need to show the co-registered image of these three modalities. 

The issue with generating a co-registered image of these data is that the OCT generates a 3D 

mesh, the brightfield microscope a 2D image, and the fluorescence microscope integrates 

the light intensity within a volume. Co-registration of these three image modalities is not 

trivial and outside the scope of this manuscript, which is limited to describing a protocol for 

the simultaneous collection of these data.  

Minor Concerns: 

1. Authors should mention their approach as 'ex vivo' in title as well as in main text 

(wherever applicable). 

Ex vivo has been added to the title and, where applicable, in the main text. 



This piece of the submission is being sent via mail. 
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